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ADVANCED ACCESS

MODIFYING TABLES AND RELATIONSHIPS

1 OF 7 (1-3 DEFINING RELATIONSHIPS)

When you have created the tables in Access for each subject in your database, you need to define the relationships between the tables.  When you define a relationship between two tables, you create an association between common fields in the tables.  You can define different types of relationship using Access, such as one-to-one and many-to-many.  The ‘1' above the line that shows the join between two tables indicates the ‘one' side of a one-to-many relationship while the infinity symbol indicates the ‘many' side.  In a one-to-one relationship each record in the first table has only one matching record in the second table.  While each record in the second table can only relate to one record in the first.  However, a one-to-one relationship is uncommon because most information that is related in this way would be found in one table.  You could use a one-to-one relationship for security.  For example, you could hide data that should be in one table by splitting the table into two tables in a one-to-one relationship.  In a many-to-many relationship a record in one table can have many matching records in a second table.  And the records in the second table can have many matching records in the first.  This type of relationship relies on a third table, called a junction table, whose primary key consists of the foreign keys from both tables.  You can define relationships by adding the tables, that you want to relate, to the Relationship window.  To set relationships, you select Relationships from the Tools menu.   You can also open the Edit relationship dialog box by selecting Edit Relationship from the Relationships menu.  If your tables are not already related, you need to add them to the Relationship window.  You need to close all open tables before you can create or modify relationships.  You create the relationships by dragging the key field from one table to the related key field in the other table.  The Primary key or Unique Index key, which is displayed in bold text, is a unique identifier for each field in a table.  When you set relationships, you can choose to update or remove related records by selecting the Enforce Referential Integrity checkbox.  You can choose to update corresponding values in the related table when you update the primary key on the primary table by selecting the Cascade Update Related Fields checkbox.  You can choose to have records deleted from the related table when records in the primary table are deleted by selecting the Cascade Delete Related Records checkbox.
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Let's say you want to create a relationship that you can use to hide a customer's credit rating from the main Customers table.  To do this, you use the Customers and Credit tables and you create a one-to-one relationship between them.  You select Edit Relationship from the Relationships menu.  To create a new relationship, you click the Create New button.  You select Customer Credit from the Left Table Name drop-down list.  You select Customers from the Right Table Name drop-down list.  You select CustomerID from the Left Column Name drop-down list.  And you select CustomerID from the Right Column Name drop-down list.  Then you click OK.  You click the Create button to create the relationship.   And you can see the relationship in the Relationship window.
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Let's say you want to create a many-to-many relationship between your Products table and your Orders table.  To do this, you must first create a junction table called Order Details.

To create the many-to-many relationships, you need to create two one-to-many relationships between the junction table and your two main tables.  You select Relationships from the Tools menu.  To add the relevant tables, you click the Show Tables button.  You select the tables by holding the Shift key and clicking the Products menu and you click Add.  On the Show Table dialog box, you click Close.  Your tables are ready for you to begin creating the relationship.  You can rearrange the tables by dragging them to their new positions in the window.  In the Relationship window you drag the OrderID key from Order table to the ProductID in the Order Details junction table.  To ensure that relationships remain valid when fields are altered, you select the Enforce Referential Integrity checkbox.  And you select the Cascade Delete Related Records checkbox.   You click Create in the Edit Relationships dialog box.  And the relationship line is created.  You drag the ProductID field from the Products table to the Order Details table.  You select ProductID from the Related Table/Query drop-down list.  You select the Enforce Referential Integrity checkbox.  Then you select the Cascade Delete Related Records checkbox.  And you click Create.  As you can see in the Relationships window, the tables now have a many-to-many relationship.

4 OF 7 (4-5 DATA VALIDATION)

You can sometimes make mistakes when entering data into a table.  You can set data validation rules for the information that you enter in a table to help prevent errors from occurring in your database.  A validation rule is an expression that limits the data that can be entered into a field, table, or query.  If a user enters data that breaks the rule, Access displays an error message telling the user what type of data can be entered.  Access provides default error messages if you leave the Validation Text field blank.  You can use the Validation Text field to enter the error message that you want to display using up to 255 characters.  In most cases you should define the data validation and restriction by setting the field's properties in table Design view.  When you use that field in a form, the validation rules and restrictions will apply to the data entered.  You should consider the data type that the field is using when creating a validation rule.  For example, a Date/Time field will only accept data in a valid date and time format.  You can type a validation rule or use the Expression Builder when you view a table or form in Design view.  The Expression Builder button becomes available when you select the Validation Rule text field.
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Let's say your company doesn't allow stock to dwindle to fewer than 300 units.  You can prevent users from entering a stock count of less than 300 units to help prevent errors arising in your database.  You want to display the message, "Units In Stock Should Not Be Less Than 300 Units", if the validation rule is broken.  You begin in the open Products table in Design view.  Then you select the UnitsInStock field.  On the General tabbed page of the Field Properties section, you select the Validation Rule property box.  And you click the Expression Builder button.  You click Operators and scroll down.  You select >= and click Paste to insert the elements into the Expression box.  You can also double-click the elements.  Then you type 300 and click OK.  In the Validation Text property box you type Units In Stock Should Not Be Less Than 300.  And you click the Save button.  Now when you try to enter a stock figure of less than 300, Access displays the error message you specified.

6 OF 7 (6-7 OPTIMIZING DATA TYPES)

You can use each of the standard data types provided by Access to define data that you enter in a field.  For each of the fields in your table, you should select the data type that best suits how you will use that field.  For example, if you want the user to enter a monetary value in the field, you should use one of the Currency data types.  Using the Predefined formats, you can define the data types for Number, Date/Time, and Currency so that the database can find and process data quicker.  You can choose from the following Number data types to define fields in tables:

• Byte

• Integer

• Long Integer

• Single

• Double

• Replication ID

• Decimal

Of the Date/Time data types you can choose from

• General Date

• Long Date

• Medium Date

• Short Date

• Long Time

• Medium Time

• Short Time

You can choose from the following Currency data types to define a field:

• General Number

• Currency

• Euro

• Fixed

• Standard

• Percent

• Scientific
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Each of the Number data types that you can choose from provide you with further specific properties with which you can customize a field.  The Byte option allows for a single-byte integer that contains values from 0 to 255.  While the Integer option can contain a 2-byte integer ranging from minus 32,768 to plus 32,767.  A Long Integer can be used to define 4-byte data that contains values from minus 2,147,483,648 to plus 2,147,483,647.  Single and Double data types can be used for 4-byte floating-point and 8-byte floating-point values respectively.  Although Single and Double data types can be used for very large and very small numbers, they are imprecise because they are rounded up.  If you want absolute precision when using 7 significant digits for a Single data type or 15 significant digits for a Double data type, you should use Decimal field size or Currency data type.  Replication ID is a 16-byte Globally Unique Identifier (GUID) that should be used only in a database that is managed by the Replication Manager.  Decimal is a 16-byte integer with an assumed decimal precision with values ranging from minus 10 to the power of 28 to plus 10 to the power of 28.  You can represent your dates and times using the default styles.  You can also choose styles from the Regional Settings Properties in the Windows Control Panel.  You can restrict how currencies are entered in a field using the Currency options.  The default General Number does not allow commas or currency symbols.  While the Currency option takes the default Currency symbol from the Control Panel and allows two decimal places.  You can use two decimal places with the Euro symbol.  Fixed option should have at least one digit and two decimal places.  Standard option limits the entry to two decimal places and separator comments.  The Percent option describes the number as a percentage by moving the point two places to the right.  The Scientific option allows scientific notation such as 2.03E + 04 representing 2.03 x 10 to the power of 4.

END OF MODIFYING TABLES AND RELATIONSHIPS

SUMMARY: You have seen how to modify tables and relationships.  In order to make sense of the data stored in your database, you need to tell Access how the information in the tables is related. One-to-one relationships are relationships in which each record in a table has only one matching record in another table. One-to-one relationships are not very  common because this type of relationship would normally be found in one table.  In a many-to-many relationship a record in one table can have many matching records in a second table. The records in the second table can have many matching records in the first table.  To help prevent errors from occurring in your database, you can set validation rules to control how data is entered into a table or query. A validation rule is an expression that limits the data that can be entered into a field. If a user breaks the validation rule, an error message is displayed. When setting a validation rule, you should consider the data type that the field is using.  You can optimize the use of the data types in a field by defining the type of data type that you use. The Number, Date/Time, and Currency data types can all be refined. You can choose from a selection of Number data types, Date/Time data types, and Currency data types that restrict the type of data the user can enter.

UNIT TEST:

1. A _____ relationship is not very common.  A _____ relationship utilizes a junction table.

a. one-to-one

b. many-to-many

2. A junction table uses the foreign keys from both primary tables.

a. True

b. False

3. Which of the following can you do to enforce referential integrity?

a. Alter the primary key when a record is changed

b. Update records when related records are changed

c. Remove tables when a database is updated

d. Delete records when related records are changed

4. Which of the following are properties of validation rules?

a. They control how data is entered into a field

b. They are limited to date and time

c. An error message is displayed if they are broken

d. They can help prevent errors arising in your database

5. What is the maximum number of characters allowed in a Validation text field?

a. 25

b. 65

c. 255

d. 2500

6. Which of the following data types have options that can be used to optimize them?

a. Memo

b. Text

c. Date/Time

d. AutoNumber

e. Currency

7. Which of the following Number data types restricts data entry to a single-byte integer?

a. Byte

b. Integer

c. Long Integer

d. Single

8. Which Currency option does not allow a currency symbol or commas?

a. Currency

b. Fixed

c. Standard

d. General Number

ANSWERS:

1. 1st blank: one-to-one, 2nd blank: many-to-many

2. True

3. b & d

4. a, c & d

5. c

6. c & e***(b)

7. a

8. d

ADVANCED ACCESS

ADVANCED FORMS

1 OF 14 (1-4 CREATING AND MODIFYING A FORM)

Access allows you to create custom forms in Design view.  When you create forms in Design view, you can base them on an existing table, form, or query.  Or you can create a query for your form so that you can base your form on more than one existing table or form.  To create a form in Design view, you open an existing database in Form view.  And, if you want to base your new form on more than one existing table or form, you select Create form in Design view.  A blank form template then opens in Design view so that you can build your form.  To create a form based on only one table or form, you click the New button and you select the table or form you want to use as a data source in the drop-down list provided in the New Form dialog box.  If you are creating a form based on more than one table or form, you need to specify the data sources for the form in the Form properties dialog box.  To open the Form properties dialog box, you click the Properties button.  If the Detail section of the form is selected instead of the form as a whole, you select Form from the drop-down list on the Format toolbar before you click the Properties button.  Or you double-click the Form Selector button in the top-left corner of the form.  On the Data tabbed page of the Form properties dialog box, you click the Build button to open the Query builder.  To select the tables you want to use, you select the Tables tabbed page of the Show Table dialog box.  Then you select the appropriate tables, in this case the Customers and Products tables, and you click the Add button in each case.  When you have chosen the tables you want, you click Close.  Then you add the field names you want to use in your form and you click the Close button to return to Form view.  You are prompted to save the changes in your Query and you click Yes.  You are then returned to the form in Design view, where the tables you have chosen appear in the Record Source field of the Data tabbed page of the Form properties dialog box.  The fields you have chosen appear in a floating toolbar.  If the Toolbox does not appear on the screen, you click the Toolbox button to make it visible.  You can then use the Toolbox to add controls to your form.
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If you want to add a field such as the Customer ID field to your form, you select it in the floating toolbar and drag it to where you want to place it on the form.  When you have placed all the fields that you want in the table, you can move them or change their size by selecting and dragging them.  If you want to change the type of control in which a field is displayed on the form, you right-click the control to display the shortcut menu.  Then you select Change To and you select the control you want to use for the field, in this case a Combo Box.  The field you have chosen is added to your form as a control.  If you want to add controls that are not based on the fields available in the floating toolbar, you click the appropriate control button in the Toolbox, in this case the Label button.  And you click a position on the form in which you want the control to appear.  You can then type in the text you want to appear in the label and you can move the label or resize it as appropriate.   You can apply any of the usual text formatting options to control text using the Format menu.  When you have finished creating your form, you switch to Form view to view the result.  Suppose that you want to adjust the caption on the form you have created.  To do this, you open the Form properties dialog box.  And, in this case, you click the Format tab.  Then you type the new caption you want to use, in this case Products ordered, in the Caption field on the Format tabbed page.  You click the Close button to close the Form properties dialog box.  And you switch to Form view to view the new caption in the form title bar. 
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Access contains controls that allow you to place pictures, graphs, and other objects on forms.  When you place an object on a form, it is displayed in a control called an object frame.  Access has two kinds of object frames - bound and unbound.  A bound frame displays an object that is stored in a database.  An unbound frame displays an object that is not stored in the database.  When including an object, you have the choice of linking or embedding it in your form.  If you link an object to a form, Access creates a link to the object's source file in the frame.  When you edit the object in a form, changes are saved in the object's source file.  When you embed an object, Access stores a copy of it in your database file.  Changes you make to the object are applied only to the object in your database, not to the original object.  You can change the properties of individual sections of the form by right-clicking the relevant section and selecting Properties from the shortcut menu.  For example, you can select Properties in the Detail section to access the Section: Detail dialog box.  Then you can change the properties in the same way as in the Form properties dialog box.

4 OF 14

Let's say that you want to add a picture, for example of a product sample, to your form.  One way you can add a picture to a form is to click the Image button in the Toolbox.  Then you click the place on the form where you want the picture to appear.  The Insert Picture dialog box appears so that you can insert a picture from a file.  And you select the folder that contains the appropriate picture, in this case the Products folder, in the Look in drop-down list.  The graphics file extensions are automatically selected for you in the Insert Picture dialog box and the first graphics file in the folder you select is also automatically highlighted.  Then you select the file that contains the picture, in this case Cap.jpg, and you click OK.  The picture now appears in the form and you can access the Image properties dialog box to modify its properties.  You can access the picture's Properties dialog box by selecting the picture and clicking the Properties button on the Standard toolbar.  You can resize a picture on your form by dragging the corner of the picture inward or outward when the pointer shows a double-sided arrow.  The picture will then resize according to the Size Mode option you have selected in the Image properties dialog box.  If you want the picture to fit the size of the frame on the form when you resize it, you select the Zoom option in the Size Mode field.  Or you select the Stretch option, which also fits the picture to the size of the frame, but may distort the picture.  If you choose the Clip option, the picture is displayed at its actual size and parts of it are cut off when you resize the picture frame on the form.  The PictureAlignment property field allows you to change the alignment of the picture in the graphic field.

For example, you can select the Center option to ensure that the picture is centered but that it does not resize when you resize the picture frame on the form.  You can cause the picture to repeat across the graphic field by changing the PictureTiling property field value to Yes.  Suppose that you want to add a special effect to a picture once it has been placed on your form.  To do this, you click the Special Effects button on the Formatting toolbar and you select a special effect, in this case Raised, from the Special Effects drop-down box.  The Special Effect button will change depending on what effect is currently selected for the control.  You can view the result of the special effect setting in Form view.

5 OF 14 (5-9 CUSTOMIZING A FORM)

Access allows you to add a form header or footer to your form to show information or controls that remain constant for all pages.  For example, a form header may be the form title or a command button that opens related forms.  You can also display page headers and footers to show information such as a title, date, page numbers, or column headings.  Page headers and footers appear only on printed forms.  The form header and footer are not displayed by default so you select Form Header/Footer in the View menu to make the form header and footer visible.  Right-clicking the active form and selecting Form Header/Footer has the same result.  If you want to resize the header, you move your pointer to the top of the Detail title bar and drag it either upward or downward when the double-sided arrow appears.  To resize the footer, you drag the Footer title bar up or down.  Headers and footers are always added to forms together so you cannot, for example, add a header without a footer.  But you can, for instance, choose to display the form header without the form footer by right-clicking the Form Footer title bar and selecting Properties to display its property dialog box.  You can also double-click the Footer section or select Format - Properties to display the Properties box.  In the property dialog box you select No in the Visible property field to ensure that the footer is not displayed.  You can specify when a form header or a form footer is displayed by using the Form Header or Form Footer property boxes.  In these boxes you can set the Display When property to Always, Print Only, or Screen Only.  Suppose you want to add the company name as a form header to a catalog mailing list.  First you click the Label button so that you can create a label.  Then you click inside the form header to position the label and you drag its borders to resize.  You type the company name, Award Sportswear, in the header text box.  Then you select the label and you format the text using, in this case, the Font, Font Size, Fill/Back Color, and Font/Fore Color buttons on the Formatting toolbar.  You click outside the label to deselect it and save the settings.  The form header is displayed at the top of the screen in Design view and Form view, and at the top of the first page when printed.  Let's say that you want to include the date and time as a page header on the Catalog Mailing List form.  To do this, you click View - Page Header/Footer.  Then you click the Page Header title bar to select it.  To insert the date and time on the header, you click Insert - Date and Time.  In the Date and Time dialog box, you select the options you want for your page header.  In this case you select the 3/9/00 radio button, you choose to clear the Include Time checkbox, and you click OK.  The date and time options you have selected are applied in the page header but they appear only as code in Design view.  The page header is also not visible in Form view because it is displayed only when the form is printed.  
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Access allows you to adjust the properties of the controls in your form in the relevant property dialog boxes so that you can customize the way the form works.  Each control has a unique property box, so you need to select the control, for example a text box, before you can access its properties.  Once you have selected the control you want to format, in this case the Number ordered label, you right-click it and you select Properties from the shortcut menu.  You can also click the Properties button on the Standard toolbar after you have selected the control you want to format.  The Property box for each control contains the Format, Data, Event, Other, and All tabs.  Each tabbed page contains a number of property fields in which you can specify or edit properties by typing a word, a phrase, or an expression.  An expression is a command line that activates a series of events in the application. Expressions may contain functions or take the form of formulas.  The All tabbed page provides a list of all the basic property settings for a selected control.  The Format property controls the way numbers, dates, times, and text are displayed and printed.  The Format property does not affect the way in which data is stored in Access.  The Data tabbed page contains information about the source and format of the data in a control as well as providing functions for the protection and validation of data.  The data tabbed page contains information only if data is entered into the control in Design view, for example in the case of a text box.  In the Control Source field you can select the name of a field in an underlying table or form from which the control data is derived.  You can also enter code in the Control Source field when you want to specify a custom format for the data in a control.  You can use the Input Mask field to enter a default format for the data in a control.  If you do not know exactly what to enter in the Input Mask field, you can click the Build button.  The Input Mask Wizard then opens to help you build an expression for the mask, which creates a default format for data in a control.  The Validation Rule and Validation Text fields are used to determine valid data entries for a control.  For example, if your company restricts the number of baseball caps ordered to 600, you can enter a validation rule to ensure that no more than 600 caps are ordered.  To do this, you first select the Validation Rule field and then you click the Build button.  You use the Expression Builder to build an expression, in this case >600, and you click OK.  Then you enter the Validation text, in this case This is not a valid order number, in the Validation Text field.  Then, if the data entered by the user does not meet the requirements of the validation rule, the validation text is displayed in a dialog box on the form to warn the user to enter the correct data.  The Event tabbed page records the macros or the Visual Basic event procedure that is carried out when an event, for example a mouse click, occurs.  You can use the Expression Builder, Macro Builder, or Code Builder to enter an event procedure in any field to ensure that a particular action is carried out when an event occurs.  You use the Expression Builder to enter formulas, the Macro Builder to construct macros, and the Code Builder to develop Visual Basic code.  The Other tabbed page allows you to apply general settings, such as the control name and the tab positions that determine the placing of a control on the form.  It also contains a setting for a control tip - a screen tip that displays information for the user when the pointer rests on the control.
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The Format tabbed page varies in content, depending on the control you want to format and the type of data in the control.  Access provides predefined formats for Date, Time, Number, Currency, Text, Memo, and Yes/No data types.  The predefined formats depend on the country specified in the Regional Settings in the Control Panel. For example, the currency symbol appears in dollars if the Regional Setting is defined as English (United States).  The number formats available in Access are

• General - the default formats  for dates, numbers, and times

• Currency - encloses negative   numbers in parenthesis

• Fixed – two decimal places and   no thousand separators

• Standard – displays thousand   separators and two decimal places

• Percent – multiplies the number   by 100, displays two decimal   places, and adds a percentage sign

• Scientific – displays numbers in   exponential notation

You can create a custom number format to highlight numbers in your form by typing up to four specifications, separated by semi-colons, into the Format field.  If you type more than one section, the first section is applied to positive numbers, the second to negative numbers, the third to zero values, and the last section is applied to text.  If you type only one section, as in this case, all numbers are formatted in the specified way.  The default text format for control data in Access is left-aligned.  You can format custom text settings in Access using the following characters:@, &, <, >, -, +, ( ), " ", \, !, *, <color>  The @ and & symbols can be used to specify the number of characters that occur in a text string.  If there are fewer characters in the text string than in the formula, spaces are displayed where characters do not appear, and if there are more characters than spaces in the formula, the text string is cut off.  The < symbol displays all lowercase letters and the > symbol displays all uppercase letters.  The -, +, and  ( ) symbols and a blank space can be used anywhere in the format string for text.  For example, you can include text in parenthesis so that it appears in parenthesis on screen, and a plus (+) sign can be used as a place marker.  If you want to embed text in a control, you place it between double quotation marks ("text").  If you want to force text to be displayed, you use the slash (\) character directly before it, for example typing \"Jan" forces "Jan" to be displayed.  You can also force letters by printing them in double quotes, for example "Y".  The ! character forces left-alignment of text.  Access automatically formats data with special format properties, for example a color, as right-aligned.  If you do not want Access to right-align the data, you need to use an asterisk before the character format, for example, >*@@@@@@.  You use square brackets if you want your text displayed in a color, for example [Blue] "Paid".
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There are seven date and time formats you can choose with varying combinations of numbers and text.  They are

• General Date – 2/15/00 8:15pm

• Long Date – Monday, February 15, 2000

• Medium Date – 15-Feb-00

• Short Date – 2/15/00

• Long Time – 8:15:30pm

• Medium Time – 08:15pm

• Short Time – 22:15

If you do not specify a date and time format, Access displays dates in General Date format, which includes a format for time.  The Yes/No, True/False, and On/Off data formats can be used when you want Access to provide specific responses to values entered by users.  The Yes/No format is the default and is used when you want to display Yes/No values in a text box rather than with a checkbox or a radio button.  It displays zero as No and any value other than zero as Yes.  The True/False format displays zero as False and any value other than zero as True.  The On/Off format displays any zero value as Off and any value other than zero as On.  You can specify custom words or phrases for format strings in Yes/No fields by typing three sections - of which the first section is always blank - separated by semi-colons.  For example,  ; "Order placed"[Blue]; "Order to be ordered"[Red].  The second section is printed for positive (Yes) values and the third section is printed for negative (No) values.  When you format text in Access, you need to ensure that it does not conflict with the Input Mask setting because this causes the text string to be displayed incorrectly.  Yes/No fields are used where there are a limited number of possible entries in a data field and you want to emphasize a specific entry.  For example, if you use a field called Order Placed from a data source, the entry can only be positive - Order placed - or negative - Order not placed.  You can then specify a format for the form field depending on the value taken from the data source - that is, you can set the entry "Order not placed" to display in red.
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Let's say that you want to create a control for the January orders form to display text in red when a customer has not paid for an order.  You also want to include a Control Tip to remind the user to fill in the Demand subform if the payment is more than 15 days overdue.  To do this, you need to ensure that the Paid/Unpaid field in the Customers table is a Yes/No data type field.  In the January orders form Design view you click the Text Box button so that you can place a text box control on the form.  Then you place the text box on the form where you want it to appear.  And, in this case, you delete the control label because you do not need it.  To set the properties for the control, you right-click it and you select Properties from the shortcut menu.  On the Data tabbed page of the Text Box dialog box you select Paid/Unpaid in the Control Source drop-down list.  Then you click the Format tab to access the text property settings.  On the Format tabbed page, you type ; "Paid"; "Unpaid"[Red] in the Format field to set the text format for the control.  Then you click the Other tab to access the Control Tip field.  In the Control Tip field on the Other tabbed page you type If Unpaid for 15 days or more, fill in the Demand form below.  Then you click the Close button to apply the new properties to your form.  And you switch to Form view to view the result.
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You may need to display data from other forms, tables, or queries in a database on a form.  For example, you may want to do this if one form contains information about customers and another form contains a list of the products sold to them.  The process of displaying data from more than one source at once is called data synchronization.  Forms need to be linked to one another or to subforms before data can be synchronized.  To link forms to one another, you either create a command button on one form to open and synchronize data with another form, or you can display the subform within the main form.  When you create a form using the Form Wizard, you are able to select fields from more than one table in the first screen of the wizard.  You can then choose the Form with subform(s) radio button if you want to display the selected table on the form.  The selected table is then displayed on your form as an embedded subform.  You can select the Linked Forms radio button to link the forms to one another.  The wizard uses the fields you have chosen from the tables to create two separate forms and places a command button on one form to open the other form and synchronize the data.   You can also add existing tables or queries to a form as subforms, or create a subform within a subform.  You can nest up to two levels of subforms on a main form.  Nesting differs from placing a number of unrelated subforms on the main form because nested subforms are related to one another.  For example, you can create a main form that displays customers, a subform that displays orders, and another subform that displays order details.  A main form can only be displayed as a single form.  But a subform can be displayed as a

• single form

• continuous form

• datasheet

Forms and subforms have a one-to-many relationship.  The main form and the subform are usually linked by a field called a primary key that occurs in both forms, for example the Customer ID field.  The subform contains multiple records that relate to a single field in the form, for example, multiple orders placed by each customer.  The Subform Wizard usually links the subform to the main form automatically using the primary key.  But if there is no primary key to link the main form to the subform, you need to create the link yourself.  To do this, you open the main form in Design view.  In Design view, you ensure that the subform control is selected and you click the Properties button.  Then you enter the name of the linking field from the subform, in this case Product ID, in the Link Child Fields property text box.  And you enter the name of the linking field or control from the main form, in this case Customer ID, in the Link Master Fields property text box.  The linking fields in a subform cannot be controls.If you're not sure which fields to use as linking fields, you can click the Build button and the Subform Field Linker will appear to help you select a field.  When you have linked the subform to a primary key in the form, you close the Properties dialog box and you switch to Form view, where you can test the link.  The link works if the subform scrolls down to match its primary field number with the primary field number displayed in the main form.
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Suppose that you have created a form named January orders to display customers' orders in January 2000 and you want to add a subform to display details about the products the customers have purchased.  To do this, you first select January orders on the Form tabbed page.  Then you click the Design button.  The January orders form opens in Design view to allow you to edit it.  And you click the Subform/Subreport button on the Toolbox to begin creating the subform.  Then you click the place where you want the form to appear and you drag the crosshair until the outline is the size you want the subform to be.  When you have created an outline for the subform on the January orders form, the SubForm Wizard dialog box appears.  You can choose to create a subform from another form or to create it from a table or query.  In this case a table contains the required data, so you select the Use existing Tables and Queries radio button and you click Next.  You click the Tables/Queries down-pointing arrow and select Table:Products1 from the list box.  Then you select a field in the Available Fields list box, in this case the ProductID field, and you click the right-pointing arrow button to place the field in the Selected Fields list box.  When you have selected all the fields you want to place in the subform, you click Next.  Access now allows you to define the link between the main form and the subform or to choose a defining link from a list.  In this case you select the Define my own radio button and you define the Product ID as the field by which the data in the subform should be sorted.  Then you click Next.  There is no primary key linking the table to the form in this case because the January orders form is based on the Customers table, which does not contain a Product ID field.  You type a name for the new subform, in this case Product details, on the final page of the wizard and you click Finish to close the Wizard dialog box.  The subform now appears on the January orders form in Design view so that you can edit it.  Access saves the subform as a separate form and you can double-click the subform name on the Forms tabbed page to open it.  The form opens in the default view - that is, the Datasheet view.  If you want to see what the subform looks like in the main form, you double-click the main form to open it in Form view.  You can see that Access nests the Product details subform in the main form.  And you can use the navigation buttons in Form view to view the next product record in the subform.
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Let's say that you want to link the Customers form directly to the January orders form and synchronize the data without using a subform.  So you decide to add a command button to the Customers form that links it to the January orders form.  To create a command button on the Customers form, you open the form in Design view.  And you make sure that the Control Wizards button is selected in the Toolbox toolbar.  To create a command button on the form, you click the Command Button button in the Toolbox.  Then you click the place on the form where you want the command button to appear.  And the Command Button Wizard dialog box opens.  On the first page of the Command Button Wizard you select Form Operations from the Categories list box.  And you select the action you want the button to perform, in this case Open Form, in the Actions text box.  Then you click Next.  On the next page of the wizard you choose the form you want the button to open, in this case the January orders form, and you click Next.  You can then choose whether to show all the records in the form, as you do in this case, or to display only certain records.  And you can choose to display text or a picture on the command button.  When you have completed all the sections of the wizard, you enter a name for the command button and you click Finish.  The command button then appears on the form.  If you want to view the event procedure for the command button, you click the Build button in the OnClick property in the Command Button Property dialog box.And the events that make the button work are displayed for you.  When you click the command button on the Customers form in Form view, the January orders form is displayed and the records are synchronized.  You can synchronize data in a main form and a subform in the same way as you synchronize data between separate forms.

13 OF 14 (13-14 SWITCHBOARDS)

When you use the Database Wizard to create a database, a switchboard is automatically created to help you navigate around the database.  The switchboard contains buttons that allow you to open forms or reports, exit a database, or customize the switchboard.  If you create a database without using the wizard, you can create a custom switchboard for the database using the Switchboard Manager.  To access the Switchboard Manager, you select the Tools menu.  Then you select Database Utilities – Switchboard Manager.  You click Yes to begin creating the switchboard.  And you click the Edit button in the Switchboard Manager dialog box.  In the Edit Switchboard Page dialog box you type a name for your switchboard, in this case Customer database Switchboard, in the Switchboard Name text box and you click New.  The Edit Switchboard Item dialog box opens so that you can add buttons to your switchboard and specify the command carried out by each button.  For example, you type the name Orders in the Text box to name the first button and you click the Open Form In Edit Mode command in the Command drop-down list box.  When you select certain commands, for example the Open Form In Edit Mode command, Access opens another list box under the Commands drop-down list box.  In this case the Form list box opens so that you can select the form you want to open when you click the Orders button, in this case the Orders form.  Then you click OK.  To add another item to your switchboard, you click New.  And you repeat the procedure for creating a new switchboard command.  When you have added all the required items to your switchboard, you click Close.
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Suppose that you want the switchboard you have specified to open automatically when you open the database.  In the Switchboard Manager dialog box you click the name of the switchboard and you click Make Default.  If you want to edit an item in your switchboard, you open the Edit Switchboard Page dialog box, you click the item, and you click Edit.  You can also edit the switchboard in Design view.  Then you edit the item in the Edit dialog box, in this case by selecting the January orders form in place of the Orders form.  And you click OK.  If you want to delete an item from your switchboard, in this case the Employees form, you select the item and you click Delete.  Then you click Yes to delete the item.  Suppose that you have created two databases with switchboards.  You now want to link the switchboards in order to access both databases.  To do this, you click New.  In the edit Switchboard Item dialog box you select the Go To Switchboard command for one of the switchboards, and you type the name of the other switchboard, in this case Inventory database, in the list box.  And you click OK to link the switchboards.

END OF ADVANCED FORMS

SUMMARY: You have seen how to create and customize forms in Access.  Access allows you to create custom forms in Design view. Customized forms can be based on an existing form or table or, if a query is created, on multiple forms or tables.  You can modify the general form properties by editing them in the Form properties dialog box. But if you want to edit individual portions of the form, you need to select them and access their  properties separately.  You can insert pictures in a form either by embedding them in the form or by linking the form to a picture file. To embed a picture in a form, you need to insert it in a bound object frame. Linked pictures are attached to an unbound object frame.  You can customize form headers and footers so that they are displayed in Form View or when the form is printed. You place data in form headers or footers when it applies to all pages on a form. You can also create page headers and footers to display information such as page numbers.  You can increase the size of form headers and footers and you can hide the header or the footer, or both.  You can specify the control properties on your form to change the format of the data in your controls, the way the data is stored, or the series of events carried out when a control is used. You can also change general settings such as control names and the tab settings, which position controls  on the form.  You can create subforms on your forms to integrate information from other forms, tables, or queries with the main form. You can also create subforms within subforms and you can create a number of separate subforms on one main form. Subforms may be displayed as single forms, continuous forms, or datasheets.  When you use the Form Wizard or the Subform Wizard to create a subform, the subform is automatically linked to the form so that the information can be synchronized. If this link does not exist, you can create a command button that links the forms and synchronizes the data in them. You can synchronize the data between forms and subforms, forms and tables, forms and queries, or forms and other forms.  When you use the Database Wizard to create a database, it automatically creates a switchboard for the database. The Switchboard Manager allows you to create a custom switchboard for a database if the Database Wizard is not used.  A switchboard allows you to navigate around your database by clicking command buttons. It can also link two or more databases for easy access to shared information.

UNIT TEST:

1. Which of the following statements apply to creating forms in Design view?

a. You can place fields in any position on the form

b. You can edit the properties of individual sections of the form

c. You can adjust the size of the fields

d. You need to use a wizard to add controls to the form

2. Is the following statement true or false?  When you link a form to a picture file, you cannot edit the picture.

a. True

b. False

3. In which of the following ways can you alter the appearance of a picture in a form?

a. By resizing

b. By viewing it as a bitmap

c. By repeating the picture in the graphic field

d. By applying special effects

4. Which of the following statements are true of form headers and footers?

a. You can create a header on a form without creating a footer

b. Headers and footers are hidden by default

c. You can create form headers and footers or page headers and footers

d. You can place a command button in a form header

5. The _____ character prevents specially formatted data from being right-aligned in Access control fields.

a. !

b. /

c. *

d. >

6. Which of the following are used to represent letters or spaces when you format control text?

a. $

b. @

c. &

d. #

7. In which of the following ways can you format control fields?

a. You can add screen tips to the fields

b. You can synchronize fields from more than one data source in a field

c. You can change the data source that is used in a field

d. You can determine which data is valid for a field

8. Which of the following statements are true of subforms?

a. You can use subforms to synchronize data between separate forms

b. You can link a single record on a subform to multiple records on a main form

c. You can place two unrelated subforms on one form

d. You can display a subform as a datasheet

9. Which of the following can you use as a subform?

a. A table

b. A query

c. A form

d. A database

10. If you want to synchronize data between two forms without using the Form Wizard, you need to create _____ on one form to open the other form.

a. a link

b. a command button

c. a subform

d. a switchboard

11. Which of the following are true of creating a switchboard?

a. You can set a switchboard to open automatically when you open a database

b. You can create links between switchboards

c. You can open forms or tables within a database using a switchboard

d. You can link separate databases using a switchboard

12. Is the following statement true or false?  When you use the Database Wizard to create a database, it automatically creates a switchboard.

a. True

b. False

ANSWERS:

1. a, b & c

2. False

3. a, c & d

4. b, c & d***(d)

5. c

6. b & c

7. a, c & d***(bd)

8. a, c & d

9. a, b & c

10. b

11. a, b & c

12. True

ADVANCED ACCESS

ACCESS TOOLS

1 OF 8 (1-2 STARTUP OPTIONS AND PASSWORDS)

Microsoft Access allows you to control how your application is displayed and how it behaves when it is started.  For example, you can set a menu or report to be displayed when the application opens, and determine whether or not the status bar is displayed on startup.  You do this by setting startup options.  When setting startup options, you need to be aware that the options only apply to the current Access project or database.  Also, startup properties for shortcut menus, menu bars, and toolbars do not replace custom menu bars and shortcut menus specific to various forms and reports.  To access the Startup dialog box, you select Tools - Startup.  You can specify the title that appears in the application's title bar by typing the title in the Application Title text box.  You can specify a graphic to use as the application icon by typing its name and address in the Application Icon text box or by clicking the Browse button and selecting the icon that you want to use.  You can select a menu bar from the Menu Bar drop-down list.  And you can select a shortcut menu bar from the Shortcut Menu Bar drop-down list.  Setting these options allows you to control which Access functions are available.  You can specify whether or not full menus and default shortcut menus are available by selecting or clearing the appropriate checkboxes.  Using these options allows you to control which Access functions are available in a project or a database.  The specified functions are then retained the next time you start the project or database.  To display a particular form or page on startup, you select it from the Display Form/Page drop-down list.  You can also set whether or not the database window is displayed by selecting or deselecting the Display Database Window checkbox.  And you can display or hide the status bar by respectively selecting or clearing the Display Status Bar checkbox.  To allow the use of built-in toolbars, you ensure that the Allow Built-in Toolbars checkbox is selected.  And to allow toolbars and menus to be changed while you are running the application, you select the Allow Toolbar/Menu Changes checkbox.  The Startup dialog box allows you to specify whether or not Access Special Keys are available for use.  These keys can, for example, be used to prompt the display of the Visual Basic window or to pause execution.  To specify that Access Special Keys should be used, you first click the Advanced button.  Then you select the Use Access Special Keys checkbox and you click OK.  Startup options that you have selected are applied the next time that the application is opened.  To bypass the startup options that you have selected, you press the Shift key as the application opens.  An alternative method of setting startup options is to use an AutoExec macro or a combination of macros and specifying options in the Startup properties dialog box.  The AutoExec.bat file is found on your C: drive.  If you have decided to use both the dialog box and a macro, you need to remember that the macro only runs after the Startup options have been applied.  So you need to ensure that the macros that you run do not change the effect of the startup options.
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To control who is able to open a database, you can assign a database password to the database.  Assigning a database password is a simple security method that ensures that only those users who know the password are able to open the database.  However, once the database is open, no other security measures are automatically applied and any user can reset the password.  To apply security measures to an open database, you need to define user-level security.  If you want to replicate a database, it is recommended that you do not assign a database password to it.  This is because replicated databases cannot be synchronized if they have defined database passwords.  Database passwords also do not protect tables linked from a password-protected database to another database, so all users on the other database can access them.  Before you assign a database password to your database, it is advisable to make a backup copy of the database and to store the copy in a safe place.  Ensure that your database is closed and - if shared on a network - that no other user has the database open.  To assign a database password, you select Open from the File menu.  You select the database that you want to assign the password to.  And then you click the down-pointing arrow next to the Open button and select Open Exclusive from the drop-down menu.  Once the database has been opened using the Open Exclusive option, you select Tools - Security - Set Database Password.  You then type the password in the Password text box.  Database passwords are case-sensitive.  You verify the password by retyping it in the Verify text box and then you click OK.  When you open a database that has a defined database password, you are prompted to enter the password.  And the database will not open unless you enter the password correctly.  A database password cannot be recovered if it is forgotten!  To remove a database password, reopen the database using the Open Exclusive option from the Open drop-down list.  You then type the existing password in the Password Required text box and click OK.  Once you have opened the protected database, you select Tools - Security - Unset Database Password.  Then you type the existing password in the Unset Database Password text box and you click OK.  This allows you to open the database without entering a password.  If you want to assign a new database password, you remove the existing password.  And then you assign a new password following the same steps that you would use to create a database password for the first time.

3 OF 8 (3-4 ANALYSIS)

Access provides tools that analyze your database in order to help you to optimize its performance.  The Additional Wizards component provided when you set up Microsoft Office contains several analysis tools.  These include:

• the Performance Analyzer

• the Table Analyzer

• the Documenter Analyzer

The Performance Analyzer helps you to optimize the performance of your databases.  To activate the Performance Analyzer, you select Tools - Analyze.  And you select the Performance option.  The Performance Analyzer dialog box allows you to choose the objects that you want to analyze.  Each tabbed page contains a specific category of existing database objects, from which you can select subsections of the database for analysis.  To select a particular object in a database, for example a table named Employees, you can either select the checkbox next to the category or click the Select button.  And to select all the categories in a particular tabbed page, you click the Select All button.  Once you have selected all the options on each of the tabbed pages that you want to analyze, you click OK.  The Performance Analyzer then analyzes your database and displays its results in the Analysis Results text box.  The icon displayed before the analysis result indicates the type of result reached, and the Key section explains each icon.  And the Analysis Notes section details information regarding the result selected.  Recommendations and Suggestions can be implemented by the Performance Analyzer.  Recommendations identify vital issues that need to be addressed, whereas suggestions include possible improvements.  To do this you select the recommendation or suggestion that you want implemented, and you click the Optimize button.  And, once a suggestion or recommendation has been performed, it is displayed as Fixed.  Ideas can not be carried out by the Performance Analyzer and so if you want to implement the ideas, you need to carry them out yourself.  The Analysis Notes section details how you can do this and gives the reasons why you might want to follow through with the ideas suggested.  Once you have read the Analysis Notes, you click the Close button.
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The Table Analyzer and the Documenter Analyzer can be accessed through the Tools menu.  The Table Analyzer allows you to split tables that contain duplicate information, create queries, and perform other tasks to optimize how your data is stored.  It does this by guiding you through each process with the Table Analyzer Wizard.  One of the functions of the Table Analyzer is to split tables that contain duplicate data.  It can generate unique ID fields for each new table.   And it is able to create a query from the original table.  The Documenter Analyzer allows you to generate customizable reports on the objects in your database.  Let's say that you want to analyze the Relationships database object and create a report that shows relationships only.  To do this, you select Tools - Analyze - Documenter.  You click the All Object Types tab.  You select the Relationships checkbox.  The Relationships option can also be found on the Current Database tabbed page.  And you click OK.  The documentation on Relationships is displayed.  You can format it for printing using Word.  And you can alter how you view the pages.

5 OF 8 (5-6 REPLICATION AND ENCRYPTION)

Access allows you to create replicas or partial replicas of a database so that they can be worked on simultaneously by other users or off site.  When you replicate a database, a replica set is created consisting of a Design Master and one or more replicas.  All databases in the replica set contain the same information but you can only alter the structure of the database through the Design Master.  Partial replicas prevent unnecessary data replication - for example, you can create a replica that only contains data that relates to the needs of a particular user.  And with partial replicas, replicas cannot be converted to a Design Master and so your database structure is protected.  Creating replicas is useful when

• you need to reduce network traffic

• you need to share information with   remote users

• you want to make backup versions   of a large database

Before creating a replica, it is recommended that you make a backup copy of your database.  Small databases may double in size when replicated, but larger databases may only increase in size by 10 to 20 percent.  The changes made to a database when creating replicas are difficult to reverse and can increase the size of the database considerably.  To create a Design Master and replica, you select Tools - Replication - Create Replica.  You click Yes to close the database - this ensures that the database is reopened in exclusive mode.  You may be prompted to install SQL dialogs at this point, if it is not already on your computer.  And you click Yes to create a backup if you have not already created one.  You choose a folder location and a filename for the new replica in the Location of New Replica dialog box.  Or, as you do in this example, you accept the proposed location and name and you click OK.  Access creates a replica and displays an information box.  You click OK when it has completed the task.  Access displays the new Design Master.  The circular icons displayed next to the database objects indicate that they are replicas.  You can create additional replicas from the Design Master or from an existing replica using the Tools - Replication - Create Replica option.  Or you can drag the database file directly to the My Briefcase icon to create a replica to use on your laptop computer.   Data added to or changed in one or more of the databases within a replica set can be updated in all of the replicas and in the Design Master.  This process is termed synchronization.  And if conflicting changes have been made to data in separate replicas, Access will identify these conflicts and allow you to correct them.  To synchronize a replication set, you open one of the databases in the set.  Then you select Tools - Replicate - Synchronize Now.  You allow Access to close all objects by clicking the Yes button.  You can then choose to synchronize with a particular replica by selecting the Directly with Replica radio button.  And you select the replica that you want to synchronize with from the drop-down list.  If you want to make the selected replica your Design Master, you select the Make … the Design Master checkbox and you click OK.  If you use synchronizers to manage synchronization you can use a particular synchronizer or all synchronizers by selecting the relevant checkbox in the Synchronize Database dialog box.  And to begin the synchronization process, you click OK.
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Encrypting a database makes the database indecipherable for any utility application other than Access.  This can be a useful security measure when the database is being transported via telephone lines or other media.  Anyone with an Access application will be able to decrypt the database and access the data, unless you include further security measures.  Also, encryption does not restrict access to objects and so you need to apply alternative security measures if you need to restrict this access.  In order for encryption to be effective, you need to ensure that you have enough space on your disk to store both the original database and the encrypted database.  However, encryption automatically compacts a database and so the encrypted database should be slightly smaller than the original.  To encrypt a database, you first open Access without opening a database.  Then you select Tools - Security - Encrypt/Decrypt Database.  You select the database that you want to encrypt in the Encrypt/Decrypt Database window.  Then you click OK.  You can provide a new name and location for the encrypted file in the Encrypt Database As dialog box.  Or you can keep the original name and location if you want the original database to be replaced with the encrypted version.  If an encryption or decryption fails when you use the original filename and location, Access will not delete the original file. A common reason for failure is that there is not enough space to store the original database and the encrypted or decrypted version.  And you click the Save button.  To overwrite the existing file, you click Yes.  And the encrypted database replaces the original database.  To decrypt a database, you first ensure that the database is closed on your computer and that no other users have it open.  Then you select Tools - Security - Encrypt/Decrypt Database.  You select the database that you want to decrypt and you click OK.  You select a location and filename for the database that you want to decrypt.  And you click Save.  The database is then decrypted.

7 OF 8 (7-8 MACROS)

Access allows you to use macros to execute a wide variety of tasks automatically.  This allows you to automate responses to different events without having to write code.  Access 2000 provides 53 macro actions from which you can build macros specific to your needs.  To create a new macro, you open the database you want the macro to apply to and ensure that the Database window is the only section open.  You then click the Macros button in the Object toolbar.  In the Macros section you click the New button on the toolbar to open a new Macro window.  The top section of the Macro window provides areas for you to choose the action that you want and to add comments to it.  And the bottom section - Action Arguments - provides areas for you to enter arguments to specify how the action that you have chosen should be carried out.  By default, two columns appear in the top section of the Macro window - Action and Comment.  You can add the Macro Name column by clicking the Macro Name button on the toolbar.  And you can add the Condition column by clicking the Condition button on the toolbar.  Let's say that you want to create a macro that reminds users to synchronize the information in their replica databases.  To do this, you position your insertion point in the Action column.  And you select the action that you require from the Action drop-down list - in this case MsgBox.  You can type explanatory notes in the comment section adjacent to the selected action.  This is particularly useful when you need to document macros that contain several actions.  You select the Message text box.  You type the message that you want displayed in the Message text box in the Action Arguments section of the window.  You can use the F6 key to move between sections in the macro window.And you can press F1 for help with the argument you have selected.  To deselect the Beep sound when the message box displays, you select No from the Beep drop-down list.  You select the icon to be displayed on the message box from the Type drop-down list - in this case Information.  If you want, you can type in a title for the message in the Message text box.  To save the macro you select File - Save As.  And you type the name of the macro - Sychronization Reminder - in the Save Macro … To text box, and you click OK.  You can run this macro in the database window by clicking the Run button on the toolbar.  The message box is then displayed.
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There are a number of ways in which you can run or execute a macro without selecting a macro menu option or clicking the Run button on the toolbar.  You can insert macros in forms, reports, and in controls on forms and reports, and these macros can be triggered by specified events.  For example, you can insert a macro in a control such as a combo box and specify that it run in response to an event such as a form opening.  If you want to run a macro from a button, you can use the Insert Button Wizard to link the macro to a button.  When running a macro from a control, you can link an existing macro to the control's event properties.  Or you can create a new macro to link to an event.  Suppose that you want to link two macros to a control - the Unit Price text box - on the Products form.  You want the existing Synchronization Reminder macro to run when the unit price value is updated.  And you want to create a new macro that displays the Product Popularity report as a print preview in response to a click in the Unit Price text box.  The macros that you want to create and link are known as event-based macros because they are activated by events.  To link a macro to the Unit Price text box control, you select the text box and click the Properties button on the toolbar.  The first macro that you want to link is the existing Synchronization Reminder macro, so on the Event tabbed page you position your cursor in the After Update text box.  And you select Synchronization Reminder from the drop-down list.  To create the macro that opens a report in response to a click, you position your cursor in the On Click text box.  You click the Builder button to create a new macro.  Then you select Macro Builder and click OK.  You type the name that you want to save the macro as - Popularity Report - and you click OK.  In the macro builder you select the action that you want - the OpenReport action - from the Action drop-down list.  In the Action Argument section you position the cursor in the Report Name text box.  You select the Product Popularity report from the drop-down list.  And you select Print Preview from the View drop-down list.  In this case you do not need to add filters or a Where argument.  When you have finished, you click the Save button  And you close the Builder window.  To test the macros, you close the Text Box properties dialog box.  You click the Unit Price text box.  And the Product Popularity report is displayed.  To test the Synchronization Reminder macro, you change the Unit Price and press Enter.  And the Synchronization Reminder message is displayed.

END OF ACCESS TOOLS

SUMMARY: You have seen how to use Access tools.  Access allows you to specify the startup options for a database, which determine how the database appears and behaves on startup. You can also apply a database password that needs to be entered before you can open a database. This password does not secure data once the database is open and should not be used in replicated databases as it interferes with synchronization.  Microsoft Access provides analysis tools that help you to improve the performance of your databases, tables, and documentation. The Performance Analyzer can suggest ideas for you to carry out in order to improve the performance of your database and it can carry out its own recommendations and suggestions automatically.  You can replicate databases so that mobile users can access them or to reduce network traffic. Once a database has been replicated a replication set is formed consisting of a single Design Master and one or more replicas. Changes can be made to any database in the replication set but design changes can only be made in the Design Master. Changes made to the content of the replicated databases can be synchronized to update the other members of the set.  You may need to encrypt a database if it is sent via transmission media. This measure ensures that only users with Access installed can open it. It does not restrict access to specific objects and so additional security is advised if the information is highly sensitive. Once encrypted, a database can easily be decrypted in Access.  Macros allow you to define actions and automate responses without having to write code. Access provides 53 macro actions to choose from and a simple environment in which to create macros. Macros can be linked to events or objects in  your database.

UNIT TEST:

1. Which of the following are true of setting startup options for a database in Access?

a. The startup options that you set apply to all databases that you open on your computer

b. Startup properties for short-cut menus do not replace custom menus specific to particular forms or reports

c. You can use an AutoExec macro to set startup options

d. You may not use both AutoExec macros and startup options to set options on a single databse

2. Startup _____ run before startup _____ are applied when a database is opened.

a. macros

b. options

3. A database password can be reset by any user that knows the original password.

a. True

b. False

4. Which of the following is true of the security provided by database passwords?

a. They supply user-level security once a database is open

b. They are recommended for replica databases

c. they ensure that a database can only be opened by a user that has the password

d. They protect information in tables that are linked to other databases

5. Which of the following are true of the analysis tools available in Access 2000?

a. The Table Analyzer is part of the Additional Wizards component when setting up Access on your computer

b. The Performance Analyzer is effective only in multi-user network environments

c. You can choose to analyze the performance of particular sections of your database rather than of the entire database

d. The Performance Analyzer provides information on how to carry out the ideas that it offers

6. Which of the following can be automatically implemented using the Performance Analyzer?

a. Ideas proposed by the Analyzer

b. Suggestions made by the Analyzer

c. Recommendations made by the Analyzer

d. Recommendations supplied by the user

7. What is the maximum number of Design Masters that a single replication set can contain?

a. 1

b. 3

c. 7

d. 10

8. Which of the following are true of replicated databases?

a. Replicated databases should be created for off-site laptop use only

b. The Design Master in a replication set contains more information than any of the replicas

c. You can only make structural changes to replicated databases through the Design Master

d. Using replicas reduces network traffic

9. The process for undoing the changes made to a replicated database if you no longer want to use replicas is automated by Access.

a. True

b. False

10. Which of the following are true of encryption in Access 2000?

a. Encrypted databases can be read by any Microsoft Office 2000 application

b. Encryption provides added security when databases are sent via telephone lines

c. An object in an encrypted database can be read by applications other than Access 2000

d. Encryption automatically compacts databases

e. It is easy to undo the changes made to an encrypted database if you no longer want to be encrypted

11. Which of the following are true of macros?

a. To create macros you need to know the fundamentals of the Visual Basic for Applications programming language

b. Macros can contain more than one action

c. Macros allow you to specify how particular actions are carried out

d. Macros ony contain one argument

12. Macros use _____ to specify how _____ are executed.

a. actions

b. arguments

ANSWERS:

1. b & c

2. 1st blank: options, 2nd blank: macros

3. True

4. c

5. a, c & d

6. b & c

7. a

8. c & d

9. False

10. b, c, d & e***(c)

11. b & c

12. 1st blank: arguments, 2nd blank: actions

ADVANCED ACCESS

ACCESS AND THE WEB

1 OF 8 (1-5 DATA ACCESS PAGES)

Access allows you to publish your database information to the Web by saving tables, forms, queries, or reports as web pages.  But this creates static web pages that won't reflect database updates until you export the new information.  To combat this problem, Access 2000 provides data access pages.   A data access page is a special type of web page that allows you to navigate, filter, and update data from the Internet or a corporate intranet.  You can also use data access pages from within Access to supplement the forms and reports you use.  They can be used to analyze, review, enter, or edit data and to make projections.  A data access page is connected directly to an Access or SQL Server database.  When a user's browser opens the data access page, the page's ActiveX control opens the database connection and allows the user to interact with the data access page.  An ActiveX control is a control such as a checkbox or command button that offers options to users or runs macros that automate tasks.  When users view a data access page using Internet Explorer, they are viewing their own copy of the page.  Changes that they make to the way the data is displayed affect only their own copy of the page.  However, any changes that they make to the data - such as adding or deleting values - are stored in the underlying database and are available to anyone viewing the page.  Because data access pages run largely on the user's computer, the user's environment needs to include the following:

• a win32 operating system - Windows 95 or   later versions, Windows NT, or Windows 2000  

• Internet Explorer 5.0 or later versions

• a copy of Office 2000 installed with the   ActiveX controls required by data access pages

• file-sharing access to the Access database

This makes the use of data access pages more suited to intranets, in which the environment of the user can be controlled by an administrator.  Most data access pages operate the same way as Access forms or reports.  They contain form fields that display data one record at a time and you can navigate through the records using a record navigation bar.

2 OF 8

You can view existing data access pages by clicking the Pages button on the Objects bar of the Database window.  This displays your current pages and offers three shortcuts to create a data access page.  By selecting one of the shortcuts you can choose to create your own page in design view, create a page using a wizard, or create a page from an existing web page.  Instead of using the shortcuts, you can access options for creating a data access page by clicking the New button.  This also allows you to access the AutoPage option, which creates a columnar data access page using all fields and records in an underlying table or query.  AutoPage arranges each field in the completed data access page on a separate line with a descriptive label to its left.  When you create a data access page, you can choose to group records on the page by categories.  For example, you may want to group customer records by city.  Access creates a separate navigation bar for the city field so that the user can move through the records and then click the Expand button to view the customers in a particular city.  You can use the grouping feature to create a hierarchy that groups records from general categories to specific details.  You can group using the first few characters of a text field, by a range of dates, or you can group values in a number field by ranges of values.  A user can view, sort, and filter grouped records but they cannot add, edit, or delete data.  So if you want to change data using a data access page, you must not define any grouping levels.  Access allows you to sort your recordset on data access pages.  You can sort these fields in either ascending or descending order.  You can choose to apply a theme that uses predesigned colors, fonts, and graphics to your data access page.  By selecting an option from the Choose a Theme list box in the Theme dialog box, you can preview a theme in the Sample of theme section.  You can then choose to apply the theme to your page or set it as the default theme for all future pages.
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Suppose you want to use the Page Wizard to create a data access page called Customer Orders that displays your company's customer details.  You want to use the CompanyName, BillingAddress, City, and State/Province fields from the Customers table.  And you want to include the OrderDate, ProductID, and Quantity fields from the Customer Orders query.  You want to group the records by city and you want to sort the records in descending order according to the company name and then the product ID.  Finally, you want to apply the Industrial theme to the page and open the page in Design view.  To create a data access page using the Page Wizard, you double-click the Create data access page by using wizard option in the Pages Database window.  On the first page of the wizard, you select the Customers table from the Tables/Queries drop-down list.  Next you select the CompanyName field from the Available Fields list box.  And you click the Add button.  You add the BillingAddress, City, and State/Province fields to the Select Fields list box in the same way.  To add fields from the Customer Orders query, you choose the query from the Tables/Queries drop-down list.  Next you select the OrderDate field and click Add.  You add the ProductID and Quantity fields in the same way and you click Next to move on to the next page of the wizard.  You select the City field to group the records under this field.  And you click the Add button.  You don't need to specify any grouping options so you click Next.  To sort records using the company name, you select CompanyName from the first drop-down list.  And you select the ProductID field from the second drop-down list.  Then you click Next.  On the next page of the wizard you type Customer Orders in the What title do you want for your page text box.  You want to open the page in Design view so you accept the default option to modify the page's design.  Then you select the Do you want to apply a theme to your page checkbox to apply the theme and you click Finish.
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When you click Finish on the final page of the Page Wizard, the page opens in Design view and the Theme dialog box opens automatically.  You select Industrial from the Choose a Theme list and you click OK to apply the theme.  You are then returned to Design view.  If you want to see how your page will look in a browser, you can switch to Page view by clicking the Page View button.  You can use the navigation bar to choose a city for which you want to view the customers.  You click the Expand button to view the customers associated with that city.  This displays another navigation bar that you can use to navigate through the customer records.  When you are satisfied with your page, you click the Close button.  Access asks you if you want to save the changes to the page and you click Yes.  The Save As Data Access Page dialog box opens and you browse to the location in which you want to save the page, type a name for the page, and click Save.  You are returned to the Database window and you see that your page has been saved to the list of pages.
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You can design your own data access page or modify an existing page in Design view.  When you open an existing page in Design view, all the page elements appear in the Data Access Page window and you can then add, modify, or delete page elements.  You can rearrange elements on a page by selecting an element and dragging it to where you want it to appear.  To resize an element, you drag an edge or a corner of the element to the size you want it to be.  You can add elements to a page using the Toolbox.  To open the Toolbox, you click the Toolbox button on the Standard toolbar.  The objects on the Toolbox are similar to those used for forms or reports but there are some additional objects.  The Bound HTML button allows you to display a bound text or memo field as formatted HTML.   The Scrolling Text button allows you to display text from a field or expression by scrolling the text across an object at a specified rate.  And the Hotspot Image button allows you to define a picture that contains a hyperlink to a document or another page on your web site.  The Expand button allows you to create an element that expands or contracts a grouped display when the user clicks it.  And the Record Navigation button allows a user to navigate from record to record, sort data, apply filters, and delete rows in a data access page that can be updated.  Access does not allow you to select multiple elements in the data access page in Design view, so to align or resize elements you need to use the Alignment and Sizing toolbar.  If you want to align more than one element, for example on the right-hand side of a page, you select the first element and click the Align Right button on the toolbar.  Then you select the second element.  If you want to align or resize a number of elements, you temporarily lock down an alignment or sizing button by double-clicking it.  The second field is automatically aligned to the right and the first field is selected again.  You can view the properties for any of the page's fields by double-clicking the field.  If you want to view the properties of the page itself, you open the Properties window and then click the Data Access Page window's title bar.  You can also choose Select Page from the Edit menu.  The Database tabbed page of the Field List dialog box displays a list of all the tables and queries in the database and their fields.  You add any fields or tables to the page by selecting and dragging them onto the page.  If no relationship exists between an added table and those already present on the page, Access prompts you to specify one.  The Page tabbed page lists all those tables and fields already present on a page.  Selecting a field on the tabbed page selects it on the page as well.  You can group records on a data access page by selecting the field that you want to group records under.  And you click the Promote button on the toolbar.  To group on a table or a query, you click the Group by Table button and if you want to merge two groups or move a field to a lower group level, you click the Demote button.  This creates a grouped field with an Expand button.  To sort records in Design view, you click the Sorting and Grouping button on the toolbar.  You click the group record source for which you want to set the sort order and you type the name of the field you want to sort by in the Default Sort text box.  By default Access sorts in ascending order, but you can specify the order by typing a space and the keyword ASC or DESC after the field name.  When you have finished modifying your data access page, you can view the results in Page view and make further changes if necessary.

6 OF 8 (6-8 HYPERLINKS)

Access allows you to insert hyperlinks in the datasheets, forms, and reports in your database.  Hyperlinks are pointers or links to a file or document outside your database.  They make it easy for users to navigate between files and database objects while they are working with the database.  You can create hyperlinks to

• other objects in the same database

• other Access databases

• Microsoft Word documents

• Microsoft Excel worksheets

• documents on a local intranet

• documents on the Internet

You can create a hyperlink from one data access page to another in the same database.  A hyperlink address consists of up to four parts that are separated by the number (#) sign.  The displaytext, which is an optional descriptor, is the first part of an address.  It is the text that is displayed in the field or control  where the hyperlink is being placed.  The second part of a hyperlink address is the address, which is the path to the target document.  It can be expressed as a Uniform Resource Locator (URL), which points to an Internet or intranet site.  Or it can be expressed as a Universal Naming Convention (UNC) path, which is an address to a file on a local area network.The subaddress, which is optional, specifies a location within a target file.  For example, it may point to a bookmark in a Word document, a range of cells in an Excel spreadsheet, or a form in an Access database.  The final part of a hyperlink address is the screentip.  A screentip appears when you move the pointer over a hyperlink.  It should be separated from the subaddress by a number (#) sign.  When you rest the pointer over a hyperlink in a document, the pointer appears as a hand.  You then click the hyperlink, which will execute the application that supports the link and open the linked file.  If your link points to a Word document, for example, Word is opened and the relevant document displayed.
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To add a hyperlink to a table, you open the table in Design view by clicking the Design button.  Then you click the next available row and type a name for the new field that will contain the hyperlink.  And you select Hyperlink as the data type for the field.  You click the Save button to save your changes.  Then you change to Datasheet view by clicking the Datasheet View button.  Datasheet view displays the fields in the table.  If you scroll to the right, you can see that a field has been created in which you can place hyperlinks.  To add a hyperlink, you click the record into which you want to place the hyperlink.  Then you click the Insert Hyperlink button to choose the object to which you want to create a link.  You can also type the hyperlink address of the object.  In the Insert Hyperlink dialog box you can insert a hyperlink to

• an existing file or web page

• an object in the database

• a new document

• an e-mail address

If you know the address of the document to which you want to create a link, you can type it in the Type the file or Web page name text box.  Or, if you have accessed the document recently, you can use the Recent Files, Browsed Pages, or Inserted Links buttons to select it from a list of files or web pages that you have visited recently.  If you do not know the location of the document to which you want to create a link or have not used it recently, you can use the File or Web Page buttons.  These buttons allow you to browse to a file or web page on your local computer or any networked computer to which you are connected.  Once you have specified a file or web page to link to, the Bookmark button allows you to browse to a named location, such as a bookmark in a Word document, within that file or web page.  You can type the displayname for the hyperlink in the Text to display text box.  And you can click the ScreenTip button to specify a screentip for the link.  You type a screentip and click OK.  When you have finished specifying your hyperlink, you click OK to save your link.  The hyperlink now appears in the selected record's hyperlink field underlined in blue.  To view the hyperlinked document, you simply click the link and the document opens.  To edit a hyperlink, you right-click the link and choose Hyperlink from the shortcut menu.  This allows you to open the linked document, copy the link to the clipboard, or add the link to your Windows favorites.  It also allows you to edit the link, change the text displayed in the field, or remove the hyperlink.
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In addition to allowing you to add hyperlinks to tables, Access allows you to place hyperlinks in forms and reports.  You can create both labels and command buttons that contain hyperlinks.  Suppose you want to add a label that contains a hyperlink that connects the Order Form page on your web site to the Orders form in your database.  To do this, you first open the form in Design view by clicking the Design button.  In Design view you click the Insert Hyperlink button.  And you click the Web Page button in the Insert Hyperlink dialog box to browse to your web page.  Internet Explorer opens and you browse to your web page.  Then you return to Access by pressing the Alt+Tab keys.  The path to the web page appears in the Type the file or Web page name text box and you click OK.  A label containing the hyperlink is added to the form.  You can move the label by clicking and dragging it to a new position.  To change the properties of the hyperlink, for example the display text, you right-click the label and select Properties.  The Caption property specifies the display text so you type the new display text in the Caption text box.  And you click the Close button.  The display text has been changed.  And you can click the Form View button to view the hyperlink on your form.  To follow the hyperlink you simply click it.  In this case the hyperlink opens the web page in Internet Explorer.

END OF ACCESS AND THE WEB

SUMMARY: You have seen how to use Access to publish to the Web and how to insert hyperlinks.  A data access page is a special type of web page that allows you to navigate, filter, and update data from the Internet or a corporate intranet. You can also use data access pages from within Access to supplement the forms and reports you use. They  can be used to analyze, review, enter, or edit data and to make projections.  When users view a data access page using Internet Explorer, they are viewing their own copy of the page. Any changes that they make to the way the data is displayed affect only their own copy of the page. However, any changes that they make to the data - such as adding or deleting values - are stored in the underlying database and are available to anyone viewing the page.  Access allows you to insert hyperlinks in the datasheets, forms, and reports in your database. Hyperlinks are pointers or links to a file or document outside your database. They make it easy for users to navigate between files and database objects while they are working with the database.  You can create hyperlinks to 

• other objects in the same database

• other Access databases

• Microsoft Word documents

• Microsoft Excel worksheets

• documents on a local intranet

• documents on the Internet

You can also create a hyperlink from one data access page to another in the same database.

UNIT TEST:

1. For which of the following can you use data access pages?

a. To analyze data

b. To review data

c. To make projections

d. To update data dynamically on a user's computer

2. Which of the following users are able to view and interact with data access pages?

a. Users with computers that are running Windows 95, have Office 2000 ActiveX controls installed, have file-sharing access to the Access database, and that are using Internet Explorer 3.0

b. Users with computers that are running Windows NT, have Office 97 ActiveX controls installed, have file-sharing access to the Access database, and that are using Internet Explorer 5.0

c. Users with computers that are running Windows 2000, have Office 2000 ActiveX controls installed, have file-sharing access to the Access database, and that are using Internet Explorer 5.0

d. Users with computers that are running Windows 95, have Office 2000 ActiveX controls installed, have file-sharing access to the Access database, and that are using Internet Explorer 5.0

3. Which of the following can a user do to data in grouped records?

a. Add data

b. Sort data

c. Filter data

d. Edit data

e. Delete data

4. You can use fields from more than one table or query on a data access page.

a. True

b. False

5. Which of the following statements about modifying data access pages in Design view are true?

a. You can select multiple elements and modify them as a group

b. You can add objects to the page using the Toolbox

c. You are limited to the fields and tables already existing on the page

d. You can choose to group records

6. Which of the following parts of a hyperlink address are optional?

a. The display text

b. The address

c. The subaddress

d. The screentip

7. The _____ part of a hyperlink address points to a location within a target file, while the _____ part is the path to the file.

a. address

b. subaddress

8. Before you insert a hyperlink in a table, you need to create a field with the Hyperlink data type.

a. True

b. False

9. To which of the following does Access allow you to insert a hyperlink?

a. A web page

b. An object in the database

c. A new document

d. An e-mail address

e. A grouped object on a data access page

ANSWERS:

1. a, b & c

2. c & d

3. b & c

4. True

5. b & d

6. a, c & d***(a)

7. 1st blank: subaddress, 2nd blank: address

8. True***

9. a, b, c & d

END OF ADVANCED ACCESS

